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Warning
Please pay attention to the following issues when purchasing or using the product:

There are small components included in this kit. Swallowing mistakenly or misoperation can
cause serious infection and be even fatal. When an accident occurs, please seek medical
assistance immediately.
Please place the product in a safe place where an under-3-year-old cannot touch, who should
not use or approach the product.
Juveniles should use the product with their parents.
Do not place the product or the components near any AC socket or other circuits, in case of
potential risks of electric shock.
Do not use the product near any liquid or flame.
Do not use or store the product in an extreme environment such as extremely cold or hot
and heavily humid.
Please remember to power off when the product is not in use.
Do not touch the moving or rotating part of the product.
The product may get heat at some part, which is just normal. But misoperation may cause
overheat.
Misoperation may cause damage to the product. Please take care.
Do not connect the positive and negative poles of the power inversely, or the devices in the
circuit may be damaged.
Please place and put the product gently. Do not smash or shock it.

About
Adeept is a technical service team of open source software and hardware. Dedicated to applying
the Internet and the latest industrial technology in open source area, we strive to provide best
hardware support and software service for general makers and electronic enthusiasts around the
world. We aim to create infinite possibilities with sharing. No matter what field you are in, we
can lead you into the electronic world and bring your ideas into reality.
The code and circuits of our product are open source. You can check on our website:

www.adeept.com

If you have any problems, feel free to send an email for technical support and assistance:
support@adeept.com

On weekdays, we usually will reply within 24 hours. Also welcome to post forums on our
website.

http://www.adeept.com
mailto:support@adeept.com
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Copyright
This user manual can be used for learning, DIY, refitting, etc., except for commercial purpose. The
Adeept Company owns all rights of contents in the manual, including but not limited to texts,
images, data, etc. Any distribution or printing should be implemented with the permission of the
Company, or it will be deemed illegal.
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A09
2 PCS

Components List
Acrylic Sheets

The acrylic sheet is covered eets with a layer of protective film. You need to remove it first.
Some holes in the acrylic shmay have residues, so you need to clean them before using it.

A11
1 PCS

A14
1 PCS

A12
1 PCS

A13
1 PCS

A01
4 PCS

A02
4 PCS

A03
9 PCS

A04
1 PCS

A05
2 PCS

A06
2 PCS

A07
1 PCS

A10
1 PCS

A08
1 PCS
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Machinery Parts

Transmission Parts
Servo x2

Rear Wheel x2
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Adeept RGB LED Module x2

Adeept ADXL345 Module x1

Adeept Passive Buzzer Module x1

Adeept UNO R3 Board x1

Electronic Parts
Adeept Remote Control Shield x1

Adeept Motor Shield x1 Adeept Nano Board x1

Adeept Ultrasonic Module x1

18650x2 Battery Holder-B x1

18650x2 Battery Holder-A x1
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Mini USB Cable x1

USB Cable x1

LED Connector x1

Buzzer Connector x1

NRF24L01 Module x2

Jumper Wire M/M x4
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18650 Battery X4

Cross Socket Wrench X1

Wingding pipe X1

Cross Screwdriver X1 Slotted Screwdriver X1

Tools

Self-prepared Parts
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Introduction
As robots are increasingly widely used in various fields nowadays, and the intelligence evolves
rapidly due to deepened innovation in recent years, they have changed greatly, and will continue
to do so, our lifestyle and broadened our view of the world. Robots can work in lots of extreme
and harsh environments where human beings cannot approach. And they can accomplish tasks
easily that we have struggled to do. So is studying robotics more and more popular. To make the
smart car robot work under the best status, it is necessary to learn more about it and seek
improvements in its speed and direction.

This robot is designed for hobbyists to learn about Arduino and robotics. Smart car robots should
first sense an obstacle before avoiding one. The sensor used in this car is an ultrasonic one. The
car detects obstacles via the ultrasonic sensor and avoids them automatically.
This smart car is a typical robot. It's composed of three parts: sensor, actuator, and MCU. Also it
can track lines – sense the leading trace and move accordingly. So the car can recognize routes
automatically, select the right path, and avoid obstacle on the path. The actuator of the car is DC
motors, which control the direction and speed of the car moving. As for MCU, an Arduino board
is used for the core of the car.

This smart car robot is really smart in moving forward/backward and turning left/right in an
unmanned manner by detecting obstacles and determining and controlling the reactions of the
car by the MCU.
In Adeept Remote Control we use ADXL345 Acceleration sensor module, just adjust the tilt Angle
of the remote control we can control the car to go forward, backward, left and right.
NRF24L01 wireless module is also used to transmit ultrasonic data to display on the computer. On
the computer, we wrote an open-source upper computer program using Processing software and
make a simulated radar interface
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Functions
The smart car has the following functions:
1. Stick mode: press the button A on remote control, then the LED1 on remote control blinks、

the LED2 lights up and LED3 goes out. At this time the four-wheel car is in stick mode.
Control the two rockers on remote car handle to make the car go forward、backward and
make a turn.

2. Intelligent obstacle avoidance mode: press the button B on remote control, then the LED1 on
remote control blinks、the LED2 goes out and LED3 lights up. At this time the four-wheel car
is in intelligent obstacle avoidance mode. When the ultrasonic module on the car detects
obstacles in front of it, it will automatically control the car to avoid obstacles.

3. Gesture control mode: press the button C on remote control, then the LED1 on remote
control blinks、 the LED2 lights up and LED3 lights up. At this time the four-wheel car is in
Gesture control mode, in this model, the ADXL345 acceleration sensor on the remote control
converts the collected information of the tilt Angle of the remote control into forward,
backward and turning information and sends it to the car to control the movement of the car.

4. Wireless radar scanning mode: the specific operation of this mode is to connect the remote
control to the computer, and run Processing program we provide (AdeeptRadarProcessing.
Pde). Press button D on the remote control, and the LED1 on the remote control flashes,
LED2 goes out and LED3 goes out. The four-wheel car is now in wireless radar scanning mode.
Data from distant car can be seen on a computer screen and displayed as a real-time radar
scan.
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Remote control:
1. Press the button A, the four-wheel car in the stick mode and the LED1 flashes, LED2 lights

up and LED3 goes out on the remote control. The four-wheel car is in stick mode. The
rocker U1 on the remote control handle pushes the car go forward and backward. The
rocker U2 on the remote control handle pushes the car to turn left and right. The rocker
U2 on the remote control handle pushes up and down to control the car ultrasonic
module to turn left and right.

2. Press the button B on the remote control and the four-wheel car is in intelligent obstacle
avoidance mode. LED1 flashes, LED2 goes out and LED3 lights up on the remote control.
When the ultrasonic module on the car detects obstacles in front of it, it will
automatically control the car to avoid obstacles.

3. Press the button C on the remote control and the four-wheel car is in gesture control
mode. LED1 flashes, LED2 lights up and LED3 lights up on the remote control. In this mode,
the ADXL345 acceleration sensors on the remote control converts the collected
information of the tilt Angle of the remote control into forward, backward and turn
instructions and sends them to the car to control the car's movement.

4. Press the button D on the remote control. The four-wheel car is in wireless radar scanning
mode, the specific operation of this mode is to connect the remote control to the
computer, and run Processing program we provide (AdeeptRadarProcessing. Pde). Press
button D on the remote control, and the LED1 on the remote control flashes, LED2 goes
out and LED3 goes out. The four-wheel car is now in wireless radar scanning mode. Data
from distant car can be seen on a computer screen and displayed as a real-time radar scan.

5. Spin the R1 potentiometer to control the startup speed of the DC motor.
6. Spin the R6 potentiometer to fine tune the direction of the car.
7. The car enters the remote control mode automatically after power on.
8. You can switch the status of the car by the remote control.
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M3*8 Screw x4

Assemble the following components

Effect diagram after assembling

A13 x1

Note: Pay attention to position of
the four standoffs on this side. If it's
not the same as this, the Uno
cannot be installed.

M3*6 Copper Standoff x4

Assembly
Fix the Position
Place four M3*6 copper standoffs on the holes of the A13 (main plate). Fix them by four M3*8
screws. Determine the orientation of the plate for the subsequent assembly.
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Assemble the following components

Effect diagram after assembling

M3 Nut x2

18650x2 Battery Holder-B x1

Note: The connector of the
holder is at the square slot.

M3*10 Countersunk Head Screw x2

Fix the Battery Holder
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Assemble the following components Effect diagram after assembling

Assemble the following Effect diagram after assembling

Insert 2 M3*30 Screws through the
holes on A08 and DC Motor, and slightly
tighten with M3 Nuts (nuts inward). Do
not tighten them, otherwise the motor
cannot rotate smoothly.

M3*8 Screw x4

M3*30 Copper Standoff x4

A10 x1

DC Motor x1

A09 x1

M3*30 Screw x2

M3 Nut x2

Rear Wheels
3.1 Fix the two DC motors on the A09 plate. Try to place the motor right in the middle position
and along the middle axis of the plate.

3.2 Fix the M3*30 copper standoffs onto the Plate A10.
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A13

Assemble the following components

Hold A09 between A13 and A10, and then
align the holes, insert and tighten the
screws.

Effect diagram after assembling

Assemble the following components

Effect diagram after assembling

Driving wheel X2

M3*8 Screw x4

3.3 Fix the part assembled in previous 3.1 and 3.2 under the A13 (main plate).

3.4 Press the rear wheels into the shaft of the motors to the farthest.

Note: The
red wires
are on the
top.

A09
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Effect diagram after assembling

Rotate the rocker arm between 0 and 180 degrees.

Assemble the following components

First, learn the structure. The servo can connect the rocker arm and spin to drive components
bound with the arm. There are 3 types of rocker arms and 3 screws in the package. The smallest
screw is to fix the arm onto the servo.

Mount and remove the rocker arm.

M3*12 Screw x4

A14 x1

A11 x1M3 Nut x4

A12 x1

Front Wheels
4.1 Connect Plate A11 and A14 with A12.

4.2 Adjust the servo with built-in rocker arms.
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Make sure all servos have been adjusted and DO NOT spin the servo shaft before the whole
assembly is done for the car. If you move it accidentally, readjust before the assembly.

Adjust the rocker arm to make it rotate to an almost equal angle towards left and right.

If the angle is not nearly the same, please remove the arm and install it again. Repeat the step until
nearly the SAME degree.

After the adjusting, the rocker arm should be in the middle axis. Remove the arm.

Effect diagram after assemblingAssemble the following components

Note: The servo shaft should be closer to
the bulges on the plate, and the nuts
underneath.

M2*10 Screw x2

M2 Nut x2

Now adjust the servo. This step is to make the servo shaft in the middle, so the component
connected to the servo can be driven to move in a certain scope as needed.

4.3 Assemble servo to Plate A06 (2 groups).

Servo x1

A06 x1
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Assemble the following components Effect diagram after assembling

Assemble the following components

M3*8 Screw x2

Effect diagram after assembling

M3*12 Copper
Standoff x2

Pay attention not to tighten the screw, otherwise the acrylic plate can't move freely.

Assemble the following components Effect diagram after assembling

M3*8 Screw x2

M3*30 Copper
Standoff x4

A04 x1

M3*8 Screw x4

Leave some space between the
screw and plate

Rocker arm

A14

Self-tapping screw
packaged with servo

4.4 Fix a servo on Plate A14.

4.5 Fix 4 M3*30 standoffs .

4.6 Connect rocker arm and Plate A04.
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Assemble the following components

Effect diagram after assembling

F624ZZ
Bearing x2

A01 x1

Front Wheel x1

M4 Spring
Washer x4

Assemble the following components

Effect diagram after assembling

A13

A02 x1

A05 x1

M4*40 Screw
x1

M4 Nut x1

A03 x3

M3*8 Screw x2

M3*12 Copper
Standoff x2

4.7 Install the front wheel (2 groups).

4.8 Fix 2 M3*6 standoffs on Plate A13.
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The rocker arm should be mounted almost perpendicular to the steering plate, so it can turn to a
nearly equal degree towards left and right. But small deviation is acceptable. If not, remove the
arm and reassemble again, instead of turning it.

Assemble the following components

From the top view, the rocker arm should be in the middle of the rotation range, so it can rotate 90
degrees towards left and right. Otherwise, you need to readjust it again based on Step 4.2 above.

F687ZZ Bearing x2

Fixing screw
packaged with servo

Effect diagram after assembling

4.9 Assemble front wheels and steering part.
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Assemble the following components

The two wheels can turn left and right.

Effect diagram after assembling

M3*8 Screw x4

F687ZZ Bearing x2

4.10 Fix the front wheels and the steering part.
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Effect diagram after assembling

Rocker Arm

A07 x1

Assemble the following components

Assemble the following components

Effect diagram after assembling

Fixing screw packaged
with servo

Note: The end of the rocker arm
should be on the slot hole.

Assemble Ultrasonic Module
5.1 Assemble the servo.

5.2 Assemble the rocker arm and Plate A07.

Servo part
assembled in

4.3

M3*8 Screw
x2
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Assemble the following components

A08

Effect diagram after assembling

Assemble the following components Effect diagram after assembling

5.3 Fix the Plate A08 and A07.

5.4 Fix the Adeept Ultrasonic Module on the part assembled in Step 5.3.

M3*12 x1

M1.4*6
Self-tapping
Screw X1

Adeept Ultrasonic
Module X1

M3 Nut x1

A08 x1
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Assemble the following components

After assembly, the
ultrasonic module should
be able to turn left and
right to 90 degrees;
otherwise you need to
adjust the servo again
based on Step 4.2.

Effect diagram after assembling

Make sure the servo is
adjusted well (shaft turned
to 90 degrees) and so the
ultrasonic facing right
ahead.

Fixing screw packaged with servo X1

5.5 Mount the part assembled in Step 5.4 to the car body.
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Effect diagram after assembling

Adeept RGB
LED Module x1

M2 Nut x2
M2*10 Screw

X1

Assemble the following components

First assemble the M2*10 screw and M2 nut into the LED module, with the screw just inserted
into the nut (as shown in the figure). Then hold the LED, press the nuts into the holes of the
module and tighten them.

RGB LED Module



www.adeept.com

23

A13

Assemble the following components

Effect diagram after assembling

Adeept UNO R3 Board x1

M3*4 Screw x4

Assemble PCBs
7.1.Mount the Adeept UNO R3 Board to A13.
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Adeept Motor Shield x1

7.2 Insert the Adeept Motor Shield onto the Adeept UNO R3 Board.

Assemble the following components

Effect diagram after assembling
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NRF24L01
Module x1

NRF24L01 module – DO NOT
plug in inversely

7.3Insert the Adeept Motor Shield onto the Adeept UNO R3 Board.

Assemble the following components

Effect diagram after assembling
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Effect diagram after assembling

Put an M3 nut on the car first, and then insert two M2*10 screws through the buzzer module,
M3 nut, the long slot on the plate at the back of the car, and then an M2 nut below the plate in
turn. During the course, you can hold the nut underneath, insert the screw through these, and
tighten them.
The M3 nut here is to support the module in height.

Assemble the following components

Assemble the Adeept Passive Buzzer Module

Adeept Passive Buzzer
Module x1

M3 Nut x2

M2 Nut x2

M2*10 Screw x2
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Assemble the following components

Effect diagram after assembling

Adeept Remote
Control Shield x1

M3 Nut x2

18650x2
Battery Holder

x1

The wiring on the 18650x2
Battery Holder shall not be
pressed between the
18650x2 Battery Holder and
the Adeept Remote Control
Shield, so as to avoid short
circuit caused by metal
puncturing on the Adeept
Remote Control Shield.

M3*10 Countersunk
Head Screw x2

Remote Control
A. Fix the 18650x2 Battery Holder and Adeept Remote Control Shield.



www.adeept.com

28

Assemble the following components

Effect diagram after assembling

Arduino Nano x1

Pay attention to the
direction of the Arduino
Nano. Do not reverse it.

B. plug Arduino Nano in Adeept Remote Control Shield.
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Assemble the following components

Effect diagram after assembling

NRF24L01 Module x1

Plug NRF24L01 in the port P4 of Adeept
Remote Control Shield.

C.Plug NRF24L01 in Adeept Remote Control Shield.
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Assemble the following components

Effect diagram after assembling

Adeept ADXL345
Module x1

Plug NRF24L01 in the port P5 of Adeept
Remote Control Shield.

D.Plug Adeept ADXL345 Module in Adeept Remote Control Shield.
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Servo to
wheels

To P4

Connect components based on the figure
Pay attention to match the wire and port and not
connect inversely.

a

abc

Motor (right
rear wheel)

Servo to
ultrasonic

To P5

Battery
Holder

Passive
Buzzer

Motor (Left
rear wheel)

abc

b
b ca

c

The servo that controls the direction
of the car should be connected to
the interface P4, and the servo that
controls the angle of the ultrasonic
module should be connected to the
interface P5. The wires should be
connected to the interface according
to the corresponding color.

Circuit Connection
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Circuit Connection of the Remote Control：
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Software & Hardware
What is Arduino？
Arduino is an open-source electronics platform based on easy-to-use hardware and software.
Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a Twitter
message - and turn it into an output - activating a motor, turning on an LED, publishing something
online. You can tell your board what to do by sending a set of instructions to the microcontroller
on the board. To do so you use the Arduino programming language (based on Wiring), and the
Arduino Software (IDE), based on Processing.

Over the years Arduino has been the brain of thousands of projects, from everyday objects to
complex scientific instruments. A worldwide community of makers - students, hobbyists, artists,
programmers, and professionals - has gathered around this open-source platform, their
contributions have added up to an incredible amount of accessible knowledge that can be of
great help to novices and experts alike.

Arduino was born at the Ivrea Interaction Design Institute as an easy tool for fast prototyping,
aimed at students without a background in electronics and programming. As soon as it reached a
wider community, the Arduino board started changing to adapt to new needs and challenges,
differentiating its offer from simple 8-bit boards to products for IoT applications, wearable, 3D
printing, and embedded environments. All Arduino boards are completely open-source,
empowering users to build them independently and eventually adapt them to their particular
needs. The software, too, is open-source, and it is growing through the contributions of users
worldwide.

Why Arduino?
Thanks to its simple and accessible user experience, Arduino has been used in thousands of
different projects and applications. The Arduino software is easy-to-use for beginners, yet flexible
enough for advanced users. It runs on Mac, Windows, and Linux. Teachers and students use it to
build low cost scientific instruments, to prove chemistry and physics principles, or to get started
with programming and robotics. Designers and architects build interactive prototypes, musicians
and artists use it for installations and to experiment with new musical instruments. Makers, of
course, use it to build many of the projects exhibited at the Maker Faire, for example. Arduino is a
key tool to learn new things. Anyone - children, hobbyists, artists, programmers - can start
tinkering just following the step by step instructions of a kit, or sharing ideas online with other
members of the Arduino community.
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Arduino Nano BoardAdeept UNO R3 Board

How Should I Use Arduino?
If you are a beginner with Arduino, Arduino learning kits on our website www.adeept.com would
be a prefect step into this fantastic field!
Two types of Arduino board are used in this car kit: Adeept UNO R3 Board and Arduino Nano
Board.

Power
The Arduino/Genuino Uno board can be powered via the USB connection or with an external
power supply. The power source is selected automatically.
External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The
adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack.
Leads from a battery can be inserted in the GND and Vin pin headers of the POWER connector.
The board can operate on an external supply from 6 to 20 volts. If supplied with less than 7V,
however, the 5V pin may supply less than five volts and the board may become unstable. If using
more than 12V, the voltage regulator may overheat and damage the board. The recommended
range is 7 to 12 volts.

The power pins are as follows:
Vin. The input voltage to the Arduino/Genuino board when it's using an external power source
(as opposed to 5 volts from the USB connection or other regulated power source). You can supply
voltage through this pin, or, if supplying voltage via the power jack, access it through this pin.
5V. This pin outputs a regulated 5V from the regulator on the board. The board can be supplied
with power either from the DC power jack (7 - 12V), the USB connector (5V), or the VIN pin of the
board (7-12V). Supplying voltage via the 5V or 3.3V pins bypasses the regulator, and can damage
your board. We don't advise it.
3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.
GND. Ground pins.
IOREF. This pin on the Arduino/Genuino board provides the voltage reference with which the

http://www.adeept.com
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microcontroller operates. A properly configured shield can read the IOREF pin voltage and select
the appropriate power source or enable voltage translators on the outputs to work with the 5V
or 3.3V.

Input and Output
Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(),
digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can provide or
receive 20 mA as recommended operating condition and has an internal pull-up resistor
(disconnected by default) of 20-50k ohm. A maximum of 40mA is the value that must not be
exceeded on any I/O pin to avoid permanent damage to the microcontroller.

In addition, some pins have specialized functions:
Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. These pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip.
External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a
rising or falling edge, or a change in value. See the attachInterrupt() function for details.
PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.
SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication using the SPI
library.
LED: 13. There is a built-in LED driven by digital pin 13. When the pin is HIGH value, the LED is on,
when the pin is LOW, it's off.
TWI: A4 or SDA pin and A5 or SCL pin. Support TWI communication using the Wire library.

The Uno has 6 analog inputs, labeled A0 through A5, each of which provide 10 bits of resolution
(i.e. 1024 different values). By default they measure from ground to 5 volts, though is it possible
to change the upper end of their range using the AREF pin and the analogReference() function.
There are a couple of other pins on the board:
AREF. Reference voltage for the analog inputs. Used with analogReference().
Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.
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Arduino Software (IDE)
Please refer to the following teaching video for IDE download and installation ：

https://youtu.be/BsTDVB8B240
Arduino Software (IDE) is used to write and upload the code for Arduino Board. First, install
Arduino software (IDE): visit https://www.arduino.cc/en/Main/Software. Download the
corresponding installation program according to your operating system. If you are a Windows
user, please select the “Windows Intaller” to download and install the driver correctly.

After the download completes, run the installer. For Windows users, there may pop up an
installation dialog box of the driver during the installation . Please agree the installation when it
appears.
After installation is completed, an Arduino software shortcut will be generated on the desktop.
Run the ide.

https://www.arduino.cc/en/Main/Software


www.adeept.com

37

The interface of Arduino software is as follows:

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text
editor for writing code, a message area, a text console, a toolbar with buttons for common
functions and a series of menus. It connects to the Arduino and Genuino hardware to upload
programs and communicate with them.

Verify : Checks your code for errors when compiling it.

Upload : Compiles your code and uploads it to the configured board.

Before uploading your sketch, you need to select the correct items from the Tools > Board and
Tools > Portmenus. The boards are described below. On the Mac OS X, the serial port is probably
something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or
/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or /dev/tty.USA19QW1b1P1.1
(for a serial board connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably
COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB board) - to find
out, you look for USB serial device in the ports section of the Windows Device Manager. On Linux,
it should be /dev/ttyACMx , /dev/ttyUSBx or similar.

Once you've selected the correct serial port and board, press the upload button in the toolbar or
select the Upload item from the Sketch menu. Current Arduino boards will reset automatically
and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press
the reset button on the board just before starting the upload. On most boards, you'll see the RX
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and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a message
when the upload is completed, or show an error.

When you upload a sketch, you're using the Arduino bootloader, a small program that has been
loaded on to the microcontroller on your board. It allows you to upload code without using any
additional hardware. The bootloader is active for a few seconds when the board resets; then it
starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will
blink the on-board (pin 13) LED when it starts (i.e. when the board resets).

Note: If you are using an external programmer with your board, you can hold down the "shift"
key on your computer when using this icon. The text will change to "Upload using Programmer"

New: Creates a new sketch.

Open: Presents a menu of all the sketches in your sketchbook. Clicking one will open it

within the current window overwriting its content.
Note:Due to a bug in Java, this menu doesn't scroll; if you need to open a sketch late in the list,
use the File | Sketchbook menu instead.

Save: Saves your sketch.

Serial Monitor: Opens the serial monitor.

Additional commands are found within the five menus: File, Edit, Sketch, Tools, and Help. The
menus are context sensitive, which means only those items relevant to the work currently being
carried out are available.

Since version 1.0, files are saved with an .ino file extension. Previous versions use the .pde
extension. You may still open .pde named files in version 1.0 and later, and the software will
automatically rename the extension to .ino.
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Install Library
The example sketches provided use the RF24.ZIP library, so you need to install it before compiling.
Click Add.ZIP Library to add the RF24.ZIP to the libraries folder.

After the library is installed successfully, you can find the RF24.ZIP under Sketchbook location: on
the window popped up by clicking Preferences.
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Upload Program
After the preparations above, next we will upload the program (example sketches provided) to
the Arduino Nano Board and Adeept UNO R3 Boards. The car kit comprises of two parts: the
remote control based on Arduino Nano Boardand the car controller on Adeept UNO R3 Board.
First, upload the sketch to Arduino Nano Board. Open the file for the remote control, the file
AdeeptRemoteControl.ino.

Connect the Arduino Nano the computer. Select Tool -> Board: "Arduino Nano"-> Arduino Nano,
and Port ->COM13. COMx is the port number assigned to the Arduino Nano and can be COM1,
COM2, COM3...So it depends.
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Next, click the upload button .

After the program is uploaded to the Nano successfully, upload another sketch to the Adeept
UNO R3. Open the program provided for the control board, the file “AdeeptMotor.ino”.
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Connect the Arduino UNO R3 Board to the PC. Select Tool -> Board “Arduino/Genuino Uno”, and
Port -> COM7. Also here is COM7, assigned to the Uno, but it can be COM1, COM2, COM3...
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Click the button to upload the sketch to the board.

About Processing
What is Processing?

Processing is a programming language, development environment, and online community.
Since 2001, Processing has promoted software literacy within the visual arts and visual
literacy within technology. Initially created to serve as a software sketchbook and to teach
computer programming fundamentals within a visual context, Processing evolved into a
development tool for professionals. Today, there are tens of thousands of students, artists,
designers, researchers, and hobbyists who use Processing for learning, prototyping, and
production.
» Free to download and open source

» Interactive programs with 2D, 3D or PDF output

» OpenGL integration for accelerated 3D

» For GNU/Linux, Mac OS X, and Windows

» Over 100 libraries extend the core software
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PROCESSING SOFTWARE

Download Processing:
https://www.processing.org/download/

For more detailed information about Processing IDE, please refer to the following link:
https://www.processing.org/reference/environment/

After downloading the decompression of the Processing software package, we do not need to
install the Processing software. And we need to connect the remote control we provided to the
computer and open the Processing software.

https://www.processing.org/download/
https://www.processing.org/reference/environment/
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Find AdeeptRadarProcessing.pde we have provided,
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Look at the following interface

Press the button D on the remote control. You'll see real-time radar scanning data from the car.
Note: when we press button D here, sometimes the car cannot send back data. We need to press
button D several times before the car can send back data. This problem is about program we
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provided. We will improve the code in this area in the next time. We will upload the updated
code to our website as soon as possible. We also welcome everybody to discuss together, study
together, make progress together in Adeept BBS (http://www.adeept.com/forum).
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Afterword
Thanks for purchasing our product and reading the manual! If you spot any errors or have any
ideas or questions for the product and this guide, welcome to contact us! We will correct them if
any as quickly as possible.
After completing all projects in the guide, you should have some knowledge of the book and
Arduino, thus you can try to change the car into other projects by adding more Adeept modules
or changing the code for extended functions.
For more information about Arduino, Raspberry Pi, smart car robot, or robotics, etc., please
follow our website www.adeept.com. We will introduce more cost-effective, innovative and
intriguing products!
Thanks again for choose Adeept product!

http://www.adeept.com
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